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Getting Started 
The following sections outline how to deploy and configure the Kelverion Integration Module for 
Atlassian Jira. 

System Requirements 
The Integration Module for Atlassian Jira requires the following software to be installed and 
configured prior to implementing the integration. For more information about installing and 
configuring Atlassian Jira, refer to the respective product documentation. 

• Kelverion Runbook Studio 5.6 

• Microsoft .NET Framework 4.7.2 

 
Atlassian Jira requirements: 

• Atlassian Jira Cloud [May 2025] 

• Atlassian Jira Data Center 10.6.0 

Deploying the Integration Module 
The easiest way to install and deploy the Integration Module for Atlassian Jira is from the PowerShell 
Gallery, but you can also download the module from Kelverion and perform the steps manually. 

You must install and deploy the Integration Module to each Azure Automation Account and Hybrid 
Worker host system that you plan to use to run your runbooks. You must also install the Integration 
Module on any Runbook Studio host systems that you will be using to build and manage your 
runbooks. 

Using the PowerShell Gallery 
Using the commands in the PowerShellGet module you can download the Kelverion Integration 
Module for Atlassian Jira from the PowerShell Gallery and install it on your local computer. You can 
also deploy the module directly from the PowerShell Gallery to any of your Azure Automation 
Accounts. 

Install the Integration Module on your local computer: 

1. Confirm that you the PowerShellGet module installed. 

2. Start a PowerShell window as Administrator and run the command: 

Install-Module -Name Kelverion.Atlassian.Jira -Scope AllUsers 
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Upload the Integration Module to an Azure Automation Account: 

1. Go to the PowerShell Gallery. 

2. Click the Azure Automation tab. 

3. Click Deploy to Azure Automation. You will be directed to Microsoft Azure. 

4. Select the Automation Account that you want to deploy the module to. 

5. Click OK. 

Manual Installation 
Alternatively, you can download the Integration Module package from Kelverion and deploy it 
manually to your local computer, hybrid workers and Automation Accounts. 

The download package from Kelverion includes a .zip file containing the Integration Module as well 
as the User Guide and Release Notes. The following instructions assume that you have unzipped the 
download package and have access to the .zip file containing the Integration Module. 

Install the Integration Module on your local computer: 

1. Copy the Kelverion.Atlassian.Jira.zip file to your local computer. 

2. Right click on the file and select Properties.  

3. Click the General tab. If necessary, click Unblock, and then click OK. 

4. Unzip the Kelverion.Atlassian.Jira.zip file. 

5. Copy the Kelverion.Atlassian.Jira folder to a location in the %PsModulePath% path. 

Important: When installing the Integration Module on a Hybrid Worker, you must use a location that 
is accessible to all users of the computer. 

Upload the Integration Module to an Azure Automation Account: 

1. Sign into Microsoft Azure. 

2. Open the Automation Account that you want to upload the module to. 

3. Click Modules under Shared Resources. The list of installed modules is displayed. 

4. Click Add a module at the top of the list. 

5. In the Upload File box, select the Kelverion.Atlassian.Jira.zip file that you downloaded. 

6. Click OK. Importing the module make take several minutes. 

  

https://www.powershellgallery.com/packages/Kelverion.Atlassian.Jira
https://portal.azure.com/
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Licensing the Integration Module 
Licenses for Kelverion Integration Modules are managed and deployed using the Kelverion Runbook 
Studio and Automation Connection Assets. 

Register an Integration Module license with Runbook Studio: 

1. Open Kelverion Runbook Studio. 

2. On the File tab, click About. 

3. Click License Information. 

4. Click the Integration Modules tab, and then click Add License. 

5. Select the integration module license file (.kaml) and click Open. 

6. You should see your entitlements displayed in the list. 

7. Click OK. 

 
Important: Entitlements will not display until after the Integration Module has been installed on the 
Runbook Studio computer. 

Create a Connection Asset with a license key and upload it to Azure: 

1. On the Home tab, click Sign In. Thy Sign In dialog appears. 

2. Sign into your account. 

3. In the Active Azure Automation Account box, select the account that you want to add the 
connection asset to. 

4. Click New Asset and then click Connection. The New Connection dialog appears. 

5. In the Name field, enter a name to identify the connection. 

6. In the Connection Type field, select the desired connection type. 

7. Enter the appropriate connection information in the provided fields. 

8. Click OK.  
Update all Connection Assets license keys and upload them to Azure: 

1. On the Home tab, click Sign In. The Sign In dialog appears. 

2. Sign into your account. 

3. In the Explorer panel, click the Azure (Online) group. 

4. Right-click the Azure Automation Account that contains the connection assets you want to 
update, and then and then click Update License Keys. A summary is displayed. 
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Acquiring an API Token for Jira Cloud 
A Jira Cloud API Token is required when configuring a connection for Jira Cloud.  

1. Log into Jira Cloud with the user you will use for your connection. 

2. Click the user avatar in the bottom left corner of the page. 

3. Click Account Settings. 

4. Click Security. 

 
5. Under the API Token section, click Create and Manage API tokens. 

 
6. Click Create API token.

 

  



 

 9 

7. Give your token a label and click the Create.  

 

8. Click Copy to copy your token for use in your connection. 
  

  



 

 10 

Working with Activities in Runbook Studio 
The following sections outline some of the common configuration options that are available to you 
when working with the activities in the Kelverion Integration Module for Atlassian Jira.  

The integration module includes the following activities: 

Add-JiraAttachment Add an attachment to an issue 

Add-JiraIssueComment Add a comment to an issue 

Add-JiraIssueWatcher Add a user as a watcher of an issue 

Add-JiraIssueWorklog Add a worklog to an issue 

Get-JiraIssue Get issue details 

Get-JiraIssueAttachment Get the attachments that have been added to an issue 

Get-
JiraIssueAttachmentContent 

Download the content of an attachment 

Get-JiraIssueComment Get the comments that have been added to an issue 

Get-JiraIssueTransition Get the transitions that can be performed on the issue 

Get-JiraIssueWatcher Get the watchers that have been added to an issue 

Get-JiraIssueWorklog Get the worklogs that have been added to an issue 

Get-JiraUser Get the users that have been assigned to a project 

Invoke-JiraIssueTransition Perform an issue transition 

New-JiraIssue Create a new issue or subtask 

Remove-JiraIssue Remove an issue 

Remove-JiraIssueAttachment Remove an attachment from an issue 

Remove-JiraIssueComment Remove a comment from an issue 

Remove-JiraIssueWatcher Remove a user as a watcher of an issue 

Remove-JiraIssueWorklog Remove a worklog from an issue 

Set-JiraIssue Update an issue 

Set-JiraIssueComment Update an issue comment 

Set-JiraIssueWorklog Update an issue worklog 

The advanced discovery capabilities provided by the activities in this integration module are only 
supported when authoring runbooks in Kelverion Runbook Studio. 
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When you publish your runbooks from Kelverion Runbook Studio to Azure Automation, the 
parameters and filters of Smart activities will automatically be converted into the parameters 
provided by the underlying command activities. 

Smart Connections 
In Kelverion Runbook Studio you can configure one or more Smart Connections to establish reusable 
links between Runbook Studio and a specific Atlassian Jira instance. You can create as many Smart 
Connections as you require, specifying links to multiple instances. You can also create multiple Smart 
Connections to the same instance to allow for differences in security privileges for different user 
accounts. 

Add a Smart Connection in Kelverion Runbook Studio: 
1. On the Home tab, click Smart Connections. The Smart Connection dialog appears. 

2. Click Add a connection at the top of the list. The Add Smart Connection dialog appears. 

3. In the Name box, enter a name for the configuration.  

4. In the Connection Type box, select Kelverion.Atlassian.Jira. 

5. In the JiraWebServiceURL box, type the web service URL of the Atlassian Jira instance.  

6. In the UserName and Password boxes, type the credentials that activity will use to connect 
to the Atlassian Jira instance. 

7. Click OK, and then click OK again. 

Global Connection Assets 
The activities in the Kelverion Integration Module for Atlassian Jira require connection information to 
connect to instances of Atlassian Jira.  

The recommended way to pass connection information to your activities in your runbooks is to use 
Global Connection Assets. Global connection assets let you securely define connection information in 
Azure which can then be retrieved on demand using either the Get-AutomationConnection cmdlet or 
Connection Asset Data Source. 

Add a global connection asset in Runbook Studio: 
1. On the Home tab, click Sign In. The Sign In dialog appears. 

2. Sign into your account. 

3. In the Active Azure Automation Account box, select the account that you want to add the 
connection asset to. 

4. Click New Asset and then click Connection. The New Connection dialog appears. 

5. In the Name box, enter a name for the configuration. 

6. In the Connection Type box, select Kelverion.Atlassian.Jira. 

7. In the JiraWebServiceURL box, type the URL of the Atlassian Jira instance.  

8. In the UserName and Password boxes, type the credentials that activity will use to connect 
to the Atlassian Jira instance. 

9. Click OK. 
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Activity Properties 
All activities in the Kelverion Integration Module for Atlassian Jira have the following properties: 

Property Description 

Label A unique label that identifies the activity in the runbook. Runbook Studio will 
provide a default name for each activity, but you can provide your own labels to 
make their role in the runbook more obvious. 

Description An optional description of the activity. Providing a description is a fantastic way 
to let everyone understand the function of the activity in the runbook. 

Checkpoint Indicates whether a checkpoint is set in the runbook workflow after the activity 
runs. Checkpoints are only available for Graphical PowerShell Workflow 
runbooks. 
If the runbook uses Azure cmdlets, you should follow best practices and follow a 
check-pointed activity with an Add-AzureRMAccount in case the runbook is 
suspended and restarts from this checkpoint on a different worker. 

Smart Discovery 
When designing runbooks in Kelverion Runbook Studio, you will notice that the activities in the 
Kelverion Integration Module for Atlassian Jira include a Discovery panel instead of the Parameter 
Sets panel that is present for standard command activities. This is because the activities in the 
Kelverion Integration Module for Atlassian Jira support interactive discovery of the Atlassian Jira 
assets in your environments. 

All activities in the Kelverion Integration Module for Atlassian Jira have a Connection option on the 
Discovery panel which lets you specify how Runbook Studio should connect to Atlassian Jira. 

When connected to Atlassian Jira, Runbook Studio will provide additional discovery options, such as 
Project and Issue Type, which can be used to specify the resources that you want to integrate with. 
Once you have filled in the discovery options Runbook Studio will provide additional parameters and, 
in some cases, filters which can be used to configure the activity. 

Smart Parameters 
Unlike standard command activities, whose parameters are determined by the Parameter Set that is 
selected, the parameters in the Kelverion Integration Module for Atlassian Jira are determined by the 
Discovery options that you specify.  

For example, when using the New-JiraIssue activity, the Discovery panel will contain options for 
selecting a Atlassian Jira Project and Issue Type. Once you have selected a form, Runbook Studio will 
provide you with parameters that coincide with the fields in the issue type. If you select another 
issue type, Runbook Studio will provide you with a separate set of parameters automatically. 

You must configure all mandatory parameters. To view the optional parameters that are associated 
with an activity, click Optional at the top of the Parameters tab.  

In addition, all activities in the Kelverion Integration Module for Atlassian Jira include a Connection 
parameter which is used to specify information that the activity will use to connect to Atlassian Jira 
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when it is executed as part of a runbook running on a Hybrid Worker. Typically, you will assign a 
Connection Asset data source to this parameter so that the activity can securely use connection 
information stored in Azure.  

The Connection parameter should not be confused with the similarly named Connection option on 
the Discovery panel which is used to specify how Runbook Studio connects to Atlassian Jira to 
provide design-time configuration options. 

Several factors determine the data sources that are available when configuring a parameter. They 
include: the parameter's data type, whether it is linked to another activity and whether the runbook 
has any input parameters. 

Runbook studio supports the following data sources. 

Activity output Specify activity whose output will be assigned to the parameter. You may also 
provide an optional Path to select a specific property of the output objects 
that are generated by the activity. 

Available when the activity is linked to a source activity. 

Not configured Clears any value that was previously configured. You must configure all 
mandatory parameters. 

Certificate asset Specify the name of the global certificate asset that will be used to provide a 
value for the parameter. 
If you have connected to Azure and selected a Subscription and Automation 
Account on the toolbar, the data source will provide the names of the 
certificates that are available. 

Credential asset Specify the name of the global credential asset that will be used to provide a 
value for the parameter. 
If you have connected to Azure and selected a Subscription and Automation 
Account on the toolbar, the data source will provide the names of the 
credentials that are available. 

Constant Specify a constant value to assign to the parameter.  
Available for parameters that have the following data types: 

• String 
• DateTime 
• Timespan 
• Decimal 
• Double 

When assigning a constant DateTime and Time values, Runbook Studio 
assumes the value is in UTC. 

Connection asset Specify the name of the global connection asset that will be used to provide a 
value for the parameter. 
If you have connected to Azure and selected a Subscription and Automation 
Account on the toolbar, the data source will provide the names of the 
connections that are available. 

Empty string An empty string will be assigned to the parameter. Available when the 
parameter is type System.String 
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Smart Filters 
Some of the activities in the Kelverion Integration Module for Atlassian Jira include a Filters panel 
which lets you specify filters that can be used to retrieve specific issues in Atlassian Jira. 

To add a filter to your activity, select the Filters panel and click Add. Filters have the following 
properties. 

Filter The name of the filter. 

Operation The operation used to evaluate the filter. Different operators will be provided 
based on the filter that is selected. Filter operators include: 

• Equals 
• Does not equal 
• Is less than 
• Is less than or equal to 
• Is greater than 
• Is greater than or equal to 

• Contains 
• Does not contain 
• Matches 
• Does not match 
• Starts with 
• Ends with 

 

Value The data source used to retrieve the value to use to evaluate the filter. 
The value used to evaluate the filter will be obtained. For more information on 
data sources, please refer to the Parameters section for more information on 
configuring data sources. 

Retry Behavior 
The activities in the Kelverion Integration Module for Atlassian Jira can be configured to run multiple 
times until a condition, which you specify, is satisfied. You can use the retry behavior options to 
configure activities that should run multiple times, that are error prone or may need more than one 
attempt for success. 

When you enable retry for an activity, you can configure the runbook to wait a specified number of 
minutes or seconds before running the activity again. If no delay is specified the runbook will run the 
activity again, immediately after it completes. 

Null A null ($null) value will be assigned to the parameter. Available when the 
parameter type is a reference type. 

PowerShell 
expression 

Specify a simple PowerShell expression whose output will be assigned to the 
parameter.  
You can use variables in the expression to access the output of an activity or a 
runbook parameter. 

Runbook input Specify the name of the runbook input parameter whose value will be 
assigned to the parameter. 
Available when the runbook has one or more input parameters. 

Variable asset Specify the name of the global variable asset that will be used to provide a 
value for the parameter. 
If you have connected to Azure and selected a Subscription and Automation 
Account on the toolbar, the data source will provide the names of the 
variables that are available. 
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The retry condition lets you specify a PowerShell expression that 
the runbook will evaluate after each time the activity runs. If the 
result of the expression is true the activity does not run again, and 
the runbook moves on to the next child activity in the runbook. 

When defining the retry conditions for your activity you can take 
advantage of a global variable called $RetryData. Specific 
information about the last time the activity ran can be accessed 
using the following properties. 

 

Property Description 

NumberOfAttempts Number of times that the activity has ran 

Output Output that was generated by the activity the last time that it ran 

TotalDuration Time elapsed since the activity was started 

StartedAt Time in UTC when the activity was first started 
 

The following are some examples of activity retry conditions 

# Run the activity exactly five times 
$RetryData.NumberOfAttempts -eq 5 
 
# Run the activity until it produces some output 
$RetryData.Output.Count -ge 1 
 
# Run the activity until at least 2 minutes has elapsed 
$RetryData.TotalDuration.TotalMinutes -ge 2 
 

Additional Parameters 
The activities in the Kelverion Integration Module for Atlassian Jira let you specify additional 
PowerShell parameters that you can use to control the behavior of the activity.  

For example, to output detailed information about the operation performed by an activity you would 
specify -Verbose:$True 

Complex Jira Field Types 
Some fields in Jira are complex and require multiple pieces of data. This list describes those fields 
and the required data. 

Jira Type Powershell Type Properties 

timetracking PSObject OriginalEstimate – TimeSpan 
RemainingEstimate – TimeSpan 
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Example: 
[PSCustomObject] @{  

 OriginalEstimate = New-TimeSpan -Days 2 

 RemainingEstimate = New-TimeSpan -Days 1 

} 
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Add-JiraIssueAttachment 
The Add-JiraIssueAttachment activity adds an attachment to an issue.  

Discovery Options 
This activity provides the following smart discovery options: 

Connection The name of the Smart Connection used to connect Runbook Studio to Jira 

Required Parameters  
This activity requires the following parameters. 

Connection Hashtable containing information used to connect to Jira  

Issue Key The key or ID of the issue that the attachment will be added to 

File Name The attachment’s file name 

Content The content of the attachment 

Optional Parameters 
This activity does not have any optional parameters. 

Output 
This activity returns the ID of the attachment that was added to the issue. 
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Add-JiraIssueComment 
The Add-JiraIssueComment activity adds a comment to an issue. 

Discovery Options 
This activity provides the following smart discovery options: 

Connection The name of the Smart Connection used to connect Runbook Studio to Jira 

Project The name of the project 

Required Parameters 
This activity requires the following parameters. 

Connection Hashtable containing information used to connect to Jira.  

Comment The comment text 

Issue Key The key or ID of the issue to add the comment to 

Optional Parameters 
This activity provides the following optional parameters. 

Visibility The group or role to which the comment is visible. By default, the comment will 
be visible to all users 

Output 
This activity returns the ID of the comment that was added. 

Remarks 
When using the Visibility parameter, the user that initially created the issue must be a member of 
the group or role that is being specified. 
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Add-JiraIssueWatcher 
The Add-JiraIssueWatcher activity adds a Jira user as a watcher of an issue. 

Discovery Options 
This activity provides the following smart discovery options: 

Connection The name of the Smart Connection used to connect Runbook Studio to Jira 

Required Parameters  
This activity requires the following parameters. 

Connection Hashtable containing information used to connect to Jira  

Issue Key The key or ID of the issue to add the watcher to 

Watcher The account ID or username of the user to add as a watcher 

Optional Parameters 
This activity does not have any optional parameters. 

Output 
Depending on the Jira instance, this activity returns either the account ID or username of the user 
that was added as a watcher.  

Remarks 
When assigning a value to the Watcher parameter, whether you use account ID or username is 
dependent on the version of Jira to which you are connecting.  
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Add-JiraIssueWorklog 
The Add-JiraIssueWorklog activity adds a worklog entry to an issue. 

Discovery Options 
This activity provides the following smart discovery options: 

Adjust Estimate Indicates how the time spent on the worklog will adjust the issue’s 
estimated time remaining.  

Connection The name of the Smart Connection used to connect Runbook Studio to 
Jira 

Project The name of the project 

Required Parameters  
This activity requires the following parameters. 

Connection Hashtable containing information used to connect to Jira 

Issue Key The key or ID of the issue to add the worklog to 

Time Spent The time spent working 

Started  The date and time that the work was started 

New Estimate The issue’s estimated time remaining (when using New) 

Reduce Estimate By The amount by which to reduce the issue’s estimated time remaining 
(when using Manual) 

Optional Parameters 
This activity provides the following optional parameters. 

Work Description The description of the work. 

Visibility The group or role that the worklog is visible to 

Output 
This activity returns the ID of the worklog entry that was added to the issue.  

Remarks 
This activity will fail if time tracking is not enabled in the Jira instance to which you are connecting. 

When configuring the activity, you must specify how the issue’s estimated time remaining will be 
adjusted. The following options are available: 

• Automatic: reduce the estimate by the time spent in the worklog. 
• Leave: leave the estimate unchanged. 
• New: assign a new value to the estimate 
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• Manual: reduce the estimate by a specified amount. 

When configuring the Visibility parameter, the user that initially created the issue must be a 
member of the group or role that is being specified. 

When configuring the Time Spent, New Estimate, and Reduce Estimate By parameters in Runbook 
Studio, you can provide a System.TimeSpan value by selecting the PowerShell Expression datasource 
and using the New-TimeSpan cmdlet. 
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Get-JiraIssue 
The Get-JiraIssue activity retrieves issue details. 

Discovery Options 
This activity provides the following smart discovery options: 

Connection The name of the Smart Connection used to connect Runbook Studio to Jira 

Search By Indicates the search strategy. Options are Filters, Query, and Issue Key. 

Required Parameters  
This activity requires the following parameters: 

Connection Hashtable containing information used to connect to Jira  

Issue Key The keys or IDs of the issues to retrieve (when searching by Issue Key). 

Query The JQL query that determines the issues to retrieve (when searching by Query). 

Optional Parameters 
This activity provides the following optional properties: 
 

Ascending Indicates that the issues should be returned in ascending order relative to the 
date and time that the issue was created. The default is descending order 

Limit The maximum number of issues to retrieve 

Offset The number of issues to skip over 

Filters 
When searching by Filters, this activity will provide filter options based on the fields that have been 
configured in the Jira instance Runbook Studio is connected to. 

Output 
This activity returns objects that represent the issues that were retrieved. The object properties are 
determined by the fields that have been configured in the Jira instance that Runbook Studio is 
connected to. 

Remarks 
When configuring the activity, you have the following search options: 

• Filters: search using one or more Runbook Studio filters 
• Query: search using a Jira Query Language (JQL) expression. 
• Issue Key: retrieve issue(s) by their key or ID. 
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When searching by Filters and Query expression you are responsible for escaping all JQL reserved 
characters and words. For more information on advanced searching using JQL, refer to the 
documentation for your Jira instance. 
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Get-JiraIssueAttachment 
The Get-JiraIssueAttachment activity gets the attachments that have been added to an issue. 

Discovery Options 
This activity provides the following smart discovery options: 

Connection The name of the Smart Connection used to connect Runbook Studio to Jira 

Required Parameters  
This activity requires the following parameters. 

Connection Hashtable containing information used to connect to Jira  

Issue Key The key or ID of the issue to retrieve attachments from 

Optional Parameters 
This activity does not have any optional parameters. 

Output 
This activity returns objects that represent issue attachments. Each attachment object has the 
following properties. 

AttachmentId The attachment ID 

Author An object representing the author of the attachment 

Created The date and time that the attachment was added 

FileName The name of the attachment 

Filesize The size of the attachment content, in bytes 

IssueKey The issue key 

MimeType The MIME type of the attachment  

Remarks 
This activity does not return the attachment content. To download the content of an attachment you 
must use the Get-JiraIssueAttachmentContent activity. 
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Get-JiraIssueAttachmentContent 
The Get-JiraIssueAttachmentContent activity downloads the content of an issue attachment. 

Discovery Options 
This activity provides the following smart discovery options: 

Connection The name of the Smart Connection used to connect Runbook Studio to Jira 

Required Parameters  
This activity requires the following parameters. 

Connection Hashtable containing information used to connect to Jira  

Attachment 
ID 

The ID of the attachment to download 

Optional Parameters 
This activity does not have any optional parameters. 

Output 
This activity returns the content of the attachment as a byte array. 
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Get-JiraIssueComment 
The Get-JiraIssueComment activity gets the comments that have been added to an issue. 

Discovery Options 
This activity provides the following smart discovery options: 

Connection The name of the Smart Connection used to connect Runbook Studio to Jira 

Required Parameters  
This activity requires the following parameters. 

Connection Hashtable containing information used to connect to Jira  

Issue Key The key or ID of the issue to retrieve comments from 

Optional Parameters 
This activity does not have any optional parameters. 

Output 
This activity returns objects that represent issue comments. Each comment object has the following 
properties. 

Author An object representing the author of the comment 

Comment The comment text 

CommentId The comment ID 

Created The date and time that the comment was added 

IssueId The issue ID 

IssueKey The issue key 

UpdateAuthor An object representing the author that updated the comment 

Updated The date and time that the comment was last updated 

Visibility The role or group that the comment is visible to 
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Get-JiraIssueTransition 
The Get-JiraIssueTransition activity gets the transitions that can be performed on an issue. 

Discovery Options 
This activity provides the following smart discovery options: 

Connection The name of the Smart Connection used to connect Runbook Studio to Jira 

Required Parameters  
This activity requires the following parameters. 

Connection Hashtable containing information used to connect to Jira  

Issue Key The key of ID of the issue to retrieve transitions from 

Optional Parameters 
This activity does not have any optional parameters. 

Output 
This activity returns objects that represent issue transitions. Each transition object has the following 
properties. 

IssueKey The issue key 

TransitionId The transition ID 

TransitionKey The transition key 
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Get-JiraIssueWatcher  
The Get-JiraIssueWatcher activity gets details of the watchers that have been added to an issue. 

Discovery Options 
This activity provides the following smart discovery options: 

Connection The name of the Smart Connection used to connect Runbook Studio to Jira 

Required Parameters  
This activity requires the following parameters. 

Connection Hashtable containing information used to connect to Jira  

Issue Key The key or ID of the issue to retrieve watchers from 

Optional Parameters 
This activity does not have any optional parameters. 

Output 
This activity returns objects that represent issue comments. Each watcher object has the following 
properties. 

AccountId The user’s account ID (empty if not supported) 

DisplayName The user’s display name 

IsActive Indicates whether the user is active 

IssueKey The key or ID of the issue that the watcher was added to 

Name The user’s username (empty if not supported) 

WatcherKey The watcher key 
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Get-JiraIssueWorklog 
The Get-JiraIssueWorklog activity retrieves details of the worklogs that have been added to an issue. 

Discovery Options 
This activity provides the following smart discovery options: 

Connection The name of the Smart Connection used to connect Runbook Studio to Jira 

Required Parameters  
This activity requires the following parameters. 

Connection Hashtable containing information used to connect to Jira  

Issue Key The key or ID of the issue to retrieve worklogs from 

Optional Parameters 
This activity does not have any optional parameters. 

Output 
This activity returns objects that represent issue worklogs. Each worklog object has the following 
properties. 

Author The author of the worklog 

Comment The work description 

Created The date and time that the worklog was added to the issue 

IssueKey The key of ID of the issue that the worklog was added to 

Started The date and time that work started 

TimeSpent The time that was spent working 

UpdateAuthor The author that most recently updated the worklog 

Updated The date and time that the worklog was mostly recently updated 

Visibility The group or role that the worklog is visible to 

WorklogId The worklog ID 

Remarks 
This activity will fail if time tracking is not enabled in the Jira instance you are connecting to. 
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Get-JiraUser 
The Get-JiraUser activity retrieves details of the users that have been assigned to a project. 

Note: The Jira API has lowered the maximum users returned from 1,000 to 100. 

Discovery Options 
This activity provides the following smart discovery options: 

Connection The name of the Smart Connection used to connect Runbook Studio to Jira 

Required Parameters  
This activity requires the following parameters. 

Connection Hashtable containing information used to connect to Jira  

Project The name of the project to retrieve user details from 

Optional Parameters 
This activity does not have any optional parameters. 

Output 
This activity returns objects that represent Jira users. Each user object has the following properties. 

AccountId The user’s account ID (empty if not supported) 

DisplayName The user’s display name 

EmailAddress The user’s email address (empty if not supported) 

IsActive Indicates whether the user is active 

Locale The user’s language locale 

Name  The user’s username (empty if not supported)  

TimeZone The user’s time zone 
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Invoke-JiraIssueTransition 
The Invoke-JiraIssueTransition performs an issue transition. 

Discovery Options 
This activity provides the following smart discovery options: 

Connection The name of the Smart Connection used to connect Runbook Studio to Jira 

Transition By Indicates whether to use Name or ID to identify the transition to perform   

Required Parameters  
This activity requires the following parameters. Additional required parameters may be provided 
depending on the fields that have been configured in the Jira environment that Runbook Studio is 
connected to. 

Connection Hashtable containing information used to connect to Jira  

Optional Parameters 
This activity may provide additional optional parameters depending on the fields that have been 
configured in the Jira environment that Runbook Studio is connected to. 

Output 
This activity returns the name or ID of the transition that was performed. 
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New-JiraIssue 
The New-JiraIssue activity adds a new issue to a project. 

Discovery Options 
This activity provides the following smart discovery options: 

Connection The name of the Smart Connection used to connect Runbook Studio to Jira 

Project The name of the project that the issue is being added to 

Issue Type The type of issue to be added 

Required Parameters  
This activity requires the following parameters. Additional required parameters may be provided 
depending on the type of issue that is being added. 

Connection Hashtable containing information used to connect to Jira  

Optional Parameters 
This activity may provide additional optional parameters depending on the type issue that is being 
added. 

Output 
This activity outputs the unique key of the issue that was added. 
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Remove-JiraIssue 
The Remove-JiraIssue activity removes one or more issues.  

Discovery Options 
This activity provides the following smart discovery options: 

Connection The name of the Smart Connection used to connect Runbook Studio to Jira 

Required Parameters  
This activity requires the following parameters. 

Connection Hashtable containing information used to connect to Jira  

Issue Key The keys or IDs of the issues to remove 

Optional Parameters 
This activity does not have any optional parameters. 

Output 
This activity returns the keys or IDs of the issues that were removed. 
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Remove-JiraIssueAttachment 
The Remove-JiraIssueAttachment activity removes one or more attachments from an issue. 

Discovery Options 
This activity provides the following smart discovery options: 

Connection The name of the Smart Connection used to connect Runbook Studio to Jira 

Required Parameters  
This activity requires the following parameters. 

Connection Hashtable containing information used to connect to Jira  

Attachment 
ID 

The IDs of the attachments to remove 

Optional Parameters 
This activity does not have any optional parameters. 

Output 
This activity returns the IDs of the attachments that were removed. 
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Remove-JiraIssueComment 
The Remove-JiraIssueComment activity removes one or more comments from an issue. 

Discovery Options 
This activity provides the following smart discovery options: 

Connection The name of the Smart Connection used to connect Runbook Studio to Jira 

Required Parameters  
This activity requires the following parameters. 

Connection Hashtable containing information used to connect to Jira  

Comment ID The IDs of the comments to remove 

Issue Key The key or ID of the issue to remove the comments from 

Optional Parameters 
This activity does not have any optional parameters. 

Output 
This activity returns the IDs of the comments that were removed. 
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Remove-JiraIssueWatcher 
The Remove-JiraIssueWatcher activity removes one or more watchers from an issue. 

Discovery Options 
This activity provides the following smart discovery options: 

Connection The name of the Smart Connection used to connect Runbook Studio to Jira 

Project The name of the project 

Required Parameters  
This activity requires the following parameters. 

Connection Hashtable containing information used to connect to Jira  

Issue Key The key or ID of the issue to remove the watchers from 

Watcher The account IDs or usernames of the users to remove as watchers 

Optional Parameters 
This activity does not have any optional parameters. 

Output 
This activity returns the account IDs or usernames of the users that removed as watchers. 

Remarks 
Whether you use account ID or username to identify the watchers to remove is dependent on the 
Jira instance to which you are connecting. 
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Remove-JiraIssueWorklog 
The Remove-JiraIssueWorklog activity removes one or more worklogs from an issue. 

Discovery Options 
This activity provides the following smart discovery options: 

Adjust Estimate Indicates how the time spent on the worklog will adjust the issue’s 
estimated time remaining. Options include Automatic, Leave, New and 
Manual. 

Connection The name of the Smart Connection used to connect Runbook Studio to Jira 

Required Parameters  
This activity requires the following parameters. 

Connection Hashtable containing information used to connect to Jira 

Issue Key The key or ID of the issue to remove the worklogs from 

Worklog ID The IDs of the worklogs to remove 

Started  The date and time that the worklog was started 

New Estimate The issue’s new estimated time remaining (when using New) 

Increase Estimate By The amount by which to increase the issue’s estimated time remaining 
(when using Manual) 

Optional Parameters 
This activity does not have any optional parameters. 

Output 
This activity returns the IDs of the worklogs that were removed from the issue. 

Remarks 
This activity will fail if time tracking is not enabled in the Jira instance you are connecting to. 

When configuring the activity, you must specify how the issue’s estimated time remaining will be 
adjusted. The following options are available: 

• Automatic: reduce the estimate by the time spent in the worklog. 
• Leave: leave the estimated unchanged. 
• New: assign a new value to the estimate 
• Manual: increase the estimate by a specified amount. 

When configuring the New Estimate and Increase Estimate By parameters in Runbook Studio, you 
can provide a System.TimeSpan value by selecting the PowerShell Expression datasource and using 
the New-TimeSpan cmdlet. 
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Set-JiraIssue 
The Set-JiraIssue activity updates one or more issues. 

Discovery Options 
This activity provides the following smart discovery options: 

Connection The name of the Smart Connection used to connect Runbook Studio to Jira 

Required Parameters  
This activity requires the following parameters.  

Connection Hashtable containing information used to connect to Jira  

Issue Key The keys or IDs of the issues to update 

Optional Parameters 
This activity provides optional parameters depending on the fields that have been configured in the 
Jira instance that Runbook Studio is connected to. 

Output 
This activity outputs the keys or IDs of the issues that were updated. 
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Set-JiraIssueComment 
The Set-JiraIssueComment activity updates an issue comment. 

Discovery Options 
This activity provides the following smart discovery options: 

Connection The name of the Smart Connection used to connect Runbook Studio to Jira 

Project The name of the project 

Required Parameters 
This activity requires the following parameters. 

Connection Hashtable containing information used to connect to Jira.  

Comment The comment text 

Issue Key The key or ID of the issue that the comment is for 

Comment Id The ID of the comment to be updated 

Optional Parameters 
This activity has the following optional parameters. 

Visibility The group or role to which the comment is visible. By default, the comment will 
be visible to all users 

Output 
This activity returns the ID of the comment that was updated. 

Remarks 
When using the Visibility parameter, the user that initially created the issue must be a member of 
the group or role that is being specified. 
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Set-JiraIssueWorklog 
The Set-JiraIssueWorklog activity updates an issue worklog. 

Discovery Options 
This activity provides the following smart discovery options: 

Adjust Estimate Indicates how the time spent on the worklog will adjust the issue’s 
estimated time remaining. . Options include Automatic, Leave, New and 
Manual. 

Connection The name of the Smart Connection used to connect Runbook Studio to Jira 

Project The name of the project that contains the issue 

Required Parameters  
This activity requires the following parameters. 

Connection Hashtable containing information used to connect to Jira 

Issue Key The key or ID of the issue that the worklogs are for 

New Estimate The issue’s new estimated time remaining (when using New) 

Time Spent The time spent working 

Worklog ID The ID of the worklog to update 

Optional Parameters 
This activity has the following optional parameters. 

Started The date and time that the work was started 

Visibility The group or role that the worklog is visible to 

Work Description The description of the work. 

Output 
This activity returns the ID of the worklog that was updated. 

Remarks 
This activity will fail if time tracking is not enabled in the Jira instance you are connecting to. 

When configuring the activity, you must specify how the issue’s estimated time remaining will be 
adjusted. The following options are available: 

• Automatic: update the estimate by the difference between the original and updated time 
spent in the worklog 

• Leave: leave the estimated unchanged. 
• New: assign a new value to the issue’s estimated time remaining.  
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When configuring the Time Spent and New Estimate parameters in Runbook Studio, you can provide 
a System.TimeSpan value by selecting the PowerShell Expression datasource and using the New-
TimeSpan cmdlet. 
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